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Thank you for downloading ZWCAD 2019! 

 

Dear Friends, 

We are glad to tell you that the long-awaited ZWCAD 2019 Official is available now! After a 

long time of devoted preparation and development, and thanks for your valuable feedback for 

the Closed and Open Beta, ZWCAD 2019 finally comes with significant new features and 

improvements, and notably enhanced efficiency and stability. Now we would like to invite you 

to take a look at this Official version. 

This Release Note mainly introduces the performance of efficiency and stability, new features 

and improvements, API, new commands and system variables, bug fixes, and limitation and 

notes in ZWCAD 2019. 

 

Yours sincerely, 

The ZWCAD Overseas Team 

 

August 2018  
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ZWCAD 2019 Official Release Note 

  VERNUM= 2018.07.26(35476)  

Overview 

ZWCAD 2019 Official has the following new features and improvements: 

New Features Description 

Create and Modify 

Dynamic Block 

Definition 

Parameters and Actions can be added to, modified in or 

removed from Dynamic Blocks. 

PDF Underlay 

PDF Underlay can be attached and displayed, supporting 

object snap, layer management, clip, the adjustment of 

display effect, etc. 

Annotative Object 
The size of annotation object can be scaled automatically 

and displayed correctly in the Layout viewports. 

DWFx Underlay DWFx format can be inserted and displayed as underlay.  

Smart Plot 
Multiple drawings in the model space can be plotted at one 

time. 

 

Improvements Description 

Layer Properties 

Manager Palette 

Layer Manager is turned into palette, enabling you to draw 

with Layer Manager on. 

Z-Tracking Z Axis can be tracked automatically. 

Custom Color 

Scheme 

Light color scheme is available as another option except for 

the default Dark scheme. 

NLM Combining 15 

Language Versions 

Network License Managers of 15 different languages are 

now integrated into one. 

Other 

Improvements 

There are many other improvements such as Redefine 

Blocks, Prompt for the Change of External Xref Files, Add 

Blocks from Design Center to Tool Palettes, etc. 

The performance of stability and efficiency, new commands and system variables, bug 

fixes, limitation and notes will also be introduced. 
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Stability 

The following section describes the stability tests in this release. 

Compare with History Versions 

The stability performance of ZWCAD 2019 is tied up with ZWCAD 2018 SP2, and 

has obvious enhancement compared with other history versions. Through the 

automatic testing by monitoring the errors during Open/Save operations in more 

than 140,400 comprehensive drawings, the correctly open rate of ZWCAD 2019 

reached 99.84%. 

 

Performance under Continuous and Intensive Usage 

Through using ZWCAD continuously and intensively for more than 4 hours 

automatically, to deal with complicated drawings with a large amount of blocks 

or polylines, it is proven that ZWCAD 2019 has a significantly stronger capability 

for long-time design work. 
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Efficiency 

The following section describes the efficiency tests in this release. 

Compare with History Versions 

Compared with the previous versions, the efficiency of COPYCLIP/PASTECLIP and 

AI_SELALL have been greatly improved, and the operation speed of SCALE and 

ROTATE also increased. However, there is slight decrease in some operations such 

as layer lock and unlock. 
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New Features 

The following section describes some details of new features in this release. 

Create and Modify Dynamic Block Definition 

 

Dynamic Blocks can be created and modified now through entering the BEDIT 

command, which can also be found in Ribbon/Classic interface, or in the right-

click menu of a dynamic block. 

As is known, the object to be changed in a Dynamic Block is targeted by 

Parameters while how it is going to be changed is defined by Actions.  

In the previous version, Dynamic Blocks can only be opened and changed by 

existing Parameters and Actions. But now more can be done -- you can create or 

modify Dynamic Blocks by adding, modifying or removing their Parameters and 

Actions. Flexibility is increased especially for complicated design tasks.  

Below are the available Parameters and Actions: 

Parameters 

Point 

Linear 

Polar 

XY 
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Rotation 

Alignment 

Flip 

Visibility 

Lookup 

Base Point 

Actions 

Move 

Scale 

Stretch 

Polar Stretch 

Rotate 

Flip 

Array 

Lookup 

PDF Underlay 

 

PDF Underlay can now be attached and displayed, supporting object snap, layer 

management, clip, displaying or hiding frames, the adjustment of display effect, 

etc. 
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Getting more data, information and drawing reference from PDF Underlay, you 

are able to make full use of it and apply it to more practical work. 

Annotative Object 

 

Annotative Object can now be displayed, created and edited. Usually, the size of 

annotation object changes together with the size of the geometry it annotates, 

resulting in its failing display in the Layout viewports when plotting to a smaller 

scale. Now by defining the annotative property to control the way that the 

annotation object scales, the size of the annotation object can be adjusted 

automatically according to the specified scale in the Layout viewports and 

displayed at the correct size, which is especially helpful for plotting drawings with 

multiple scales in multiple viewports. The annotation objects or object styles that 

can be set as annotative including: 

 Text and Text style  

 Attribute Block definition  

 Hatch  

 Dimension and Dimension style  

 Tolerance  

 Multileader and Multileader style  
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DWFx Underlay 

DWFx, an advanced format of DWF to protect your drawings, can be inserted and 

displayed as underlay now. However, only DWFATTACH is available in this version, 

while other relative commands such as DWFFRAME, DWFCLIP, DWFADJUST, 

DWFLAYER and DWFOSNAP are not available yet. 

Smart Plot 

 

Smart Plot is now available to plot multiple drawings from the model space at one 

time by using command ZWPLOT. 

Sometimes, designers prefer generating several drawings in the model space 

instead of layout space. If they want to plot the drawings, they need to plot them 

one by one.  

Now with Smart Plot, drawings can be plotted from the model space all at once 

after defining their borders and selecting the entities to be plotted, enabling more 

efficient plotting process.  
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Improvements 

         The following section describes the improvements in this release. 

Layer Properties Manager Palette 

When you open the Layer Manager before, you can only operate in its dialog box. 

But now, through turning the dialog box into a palette, you are able to operate in 

the drawing area with the Layer Manager on, and the adjustments in the Layer 

Manager can be updated instantly in the drawing area, making it more 

convenient since you no longer need to open and close the Layer Manager 

repeatedly. 

 

Z-Tracking 

Polar tracking on Z-Axis is available now in 3D design. You can draw lines parallel 

to Z Axis easily without any other construction lines. 
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Custom Color Scheme 

In the former version, Dark is the default color scheme helping reduce visual 

fatigue. Now Light is also available as another option for those who prefer white 

menu, which can be switched in Options→Display to satisfy different needs. 

 

NLM Combining 15 Language Versions 

Network License Managers (NLM) of 15 different languages are now integrated 

into one, which means that you can download the NLM you need conveniently by 

selecting between 32 bit and 64 bit. 



13 

 

Other Improvements 

         The following section describes other improvements in this release. 

Drag and Drop Layout Tab 

You can change the order of the Layout tab by dragging and dropping. What’s 

more, by pressing Ctrl while dragging the Layout tab, it will be copied to the 

specified location. 

 

Every Version is Separately Listed in the Menu Bar of Win 8 & 10 

From ZWCAD 2019, every annual and language version is listed separately in the 

menu bar of Win 8 and Win 10 to help you better manage them. 

 

Redefine Blocks 

You can now redefine the blocks in Design Center. When inserting the block of the 

same name from Design Center to the current drawing, you can redefine the block 

by selecting Insert and Redefine from the right-click menu. 
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Add Blocks from Design Center to Tool Palettes 

You can now add the blocks from Design Center to Tool Palettes simply by 

dragging and dropping them. 

 

Block Preview 

While inserting a block from a DWG file, you can preview it in the Insert Block 

dialog box 

 



15 

 

Functions Added in File Tab Menu 

Functions including Save, Save As and Open Containing Folder are added to the 

right-click menu of File Tab. 

 

Optional Prompt for Unresolved Reference Files 

Usually, if there are Unresolved Reference Files in your drawings, a prompt 

reminding that the referenced files could not be located or read will appear, and 

instruct you to choose whether to update or ignore. However, for some designers, 

they don’t need the referenced files, and will be tired of choosing “Ignore” over 

and over again.  

 

Now they can tick the option at the bottom of the prompt to always ignore the 
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unresolved reference. Of course, if they want the prompt back, they can set it 

through Options-->User Preferences-->Hide message dialog settings-

->References-Unresolved Reference Files. 

 

Prompt for the Change of External Xref Files 

In the previous version, if you make some adjustments to the External Xref Files, 

you will not receive any reminder and will probably forget the changes and get 

confused. Now a prompt will pop up reminding you of the changes, and you can 

reload the drawing by xref manager. 

 

Group Objects in Properties 

If you define several objects, like three circles as a Group, they will be marked as 

a Group in the Properties menu as below, making you clear which objects are 

Groups. 
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Highlight the Objects with Cursor over it 

When you put the cursor on an object in the process of a command, the object will 

be highlighted to ensure that you have correctly selected it. 

 

Sum Up Hatched Areas 

The hatched areas can be summed up by AREASUM command. 

 



18 

 

Other Optimizations 

 The command prompt remains displayed when turning off Dynamic 

Input. 

 Standard version supports loading VLS&ZELX files. 

 VPLAYER command is supported in Model Space. 

 The size of the output SVG files is reduced. 

 The path of External Xref Files can be updated through entering “.\”. 
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API 

The following section describes the condition of API in this release. 

ZRX 

408 were added and 35 were fixed as below. ZRX programs running correctly on 

ZWCAD 2018 Official/SP1/SP2 can be loaded on ZWCAD 2019 directly. 

Frequently-used interfaces in Brep library were added to represent topological 

information of 3D models. However, interfaces relating to Mesh is not realized yet. 

Bug ID Description 

13789\13177\ 

13175\13035\ 

12154\11518 

int acedSSGet(const ACHAR * str, const void * pt1, 

const void * pt2, const struct resbuf * filter, 

ads_name ss) 

13706\12616\ 

11451\9741 

ACDB_PORT ADESK_SEALED_VIRTUAL 

Acad::ErrorStatus GetGeomExtents 

(AcDbExtents& extents) const 

13323 
AcGeScale3d AcDbBlockReference::scaleFactors() 

const; 

13295 

AcDb3PointAngularDimension::AcDb3PointAngul

arDimensi on(const AcGePoint3d& centerPoint, 

const AcGePoint3d& xLine1Point, const 

AcGePoint3d& xLine2Point, const AcGePoint3d& 

arcPoint, AcDbObjectId dimStyle = 

AcDbObjectId::kNull) 

13187 

virtual void 

AcEditorReactor::endDeepClone(AcDbIdMapping

&) 

13157 IOPMPropertyExtensionImpl::ShowProperty 

12942 

AcGeMatrix3d& 

AcGeMatrix3d::setToPlaneToWorld(const 

AcGePlane& plane) 

12884 

AcDb2dPolyline::insertVertexAt(const 

AcDb2dVertex* pIndexVert, AcDb2dVertex* 

pNewVertex) 

12776 Int acdbEntNext (const ads_name ent, ads_name 
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result) 

12738 
Adesk::Int16 

AcDbViewportTableRecord::number() const 

12668 

Adesk::Boolean 

AcGeCircArc3d::intersectWith(const 

AcGePlanarEnt& plane, int& numOfIntersect, 

AcGePoint3d& p1, AcGePoint3d& p2, const 

AcGeTol& tol = AcGeContext::gTol) const 

12610 CWnd* acedGetAcadTextCmdLine() 

12586 

virtual Acad::ErrorStatus 

AcDbBlockReference::setScaleFactors(constAcGeS

cale3d& scale) 

12450 
virtual void AcDbEntity::dragStatus(const 

AcDb::DragStat status) 

12427 

static AcGeMatrix3d 

AcGeMatrix3d::worldToPlane(const 

AcGeVector3d& normal) 

12227 
int acedGetPoint(const ads_point pt, const ACHAR 

* prompt, ads_point result) 

12201 
int acedGetAngle(const ads_point pt, const ACHAR 

* prompt, ads_real * result) 

12189 
int acedGetDist(const ads_point pt, const ACHAR * 

prompt, ads_real * result) 

12137 double AcDbMText::actualWidth() const 

11482 
int acedGrRead(int track,int * type,struct resbuf 

*result) 

11477 

static ACPL_PORT Acad::ErrorStatus 

AcPlPlotFactory::createPreviewEngine(AcPlPlot

Engine *& pPreview,long nPreviewFlags= 

kShowPlot) 

11463 

virtual Acad::ErrorStatus 

AcPlPlotEngine::beginPlot(AcPlPlotProgress* 

pPlotProgress,void* pParams = NULL) 

11373 int acedInitGet(int val,const ACHAR * kwl) 

11158 int acedGetFunCode() 
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10704 

#define acrxDynamicLinker \ 

AcRxDynamicLinker::cast(acrxSysRegistry()->a

t(ACRX_D 

YNAMIC_LINKER)) 

10628\9725 

int acedGetFileNavDialog(const ACHAR * 

title,const ACHAR * defawlt,const ACHAR * 

ext,const ACHAR * dlgname,int flags,struct 

resbuf ** result) 

10052 

static ACPL_PORT Acad::ErrorStatus 

AcPlPlotFactory::createPublishEngine(AcPlPlot

Engine 

*& pEngine) 

9361 
int acedGetCName(const ACHAR * cmd,ACHAR 

** result) 

9332 

virtual Acad::ErrorStatus 

AcDbCurve::getParamAtPoint(const 

AcGePoint3d&,double&) const 

9315 
int acedTextBox(const struct resbuf * 

args,ads_point pt1,ads_point pt2) 

8729 
BOOL acedRegisterFilterWinMsg(const 

AcedFilterWinMsgFn pfn) 

8213 

Acad::ErrorStatus 

getDimstyleData(AcDbDimStyleTableRecord*& 

pRec) const 

4648 

AcGeBoundBlock2d 

AcGeCurve2d::boundBlock(const AcGeInterval& 

range) const 

608 
int acedGetCorner(const ads_point pt,const 

ACHAR * prompt,ads_point result) 

.NET 

2 were added and 16 were fixed as below. 

Bug ID Description 

11673 DataColumn.GetIndexAtCell (Newly-added) 
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11535 DataCellCollection.Add (Newly-added) 

13372 
Application.ActiveDocument.ModelSpace.AddPol

yline 

12593 IZcadEntity.Hyperlinks.Add 

12385 PlotEngine.BeginGenerateGraphics 

12384 DBPoint.DBPoint(Point3d) 

12769 
public ObjectId SetAt(string searchKey, 

[CallerMustClose] DBObject newValue) 

11709 AcadSortentsTable.MoveToBottom 

11681 DataColumn.InsertCellAt 

11538 DataTable.GetCellAt 

11536 DataCellCollection.IndexOf 

11536 DataCellCollection.Insert 

11536 DataCellCollection.Remove 

11536 DataCellCollection.Item.get 

11536 DataCellCollection.Item.set 

11536 DataColumn.AppendCell 

11536 DataColumn.InsertCellAt 

11536 DataColumn.SetCellAt 

VBA 

20 were fixed as below. 

Bug ID Description 

12402 3Dsolid.SliceSolid Method 

12855 Document.Add Method 

11217 Document.SaveAs Method 

10871 Document.SetVariable Method 

13153 Group. AppendItems Method 

12514 Hyperlinks.Add Method 

12302 object.AddMLine Method 
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11134\12546\12612 PaperSpace. AddPViewport Method 

10362\12329\13215 Plot.PlotToDevice Method 

12142\12893 Plot.PlotToFile Method 

12129\12719\12723 PopupMenu. AddMenuItem Method 

8718 PopupMenu. AddSubMenu Method 

12856\12858 SelectionSet.Select Method 

12877 SelectionSet. AddItems Method 

12680 BlockRef.XScaleFactor Property 

12787 Document. ActiveLayout Property 

11035 Document.PlotConfigurations Property 

12638 LightweightPolyline.Coordinates Property 

3863 PlotConfiguration.StandardScale Property 

12700 Polyline.Coordinates Property 

LISP 

5 were added and 30 were fixed as below. 

Bug ID Description 

9193 _vl-times (Newly-added) 

9194\12170\12665 acet-ss-zoom-extents (Newly-added) 

9195 acet-list-remove-adjacent-dups (Newly-added) 

11768 vports (Newly-added) 

12288 rotate3d (Newly-added) 

3701, 8909 getcname 

4284 acad_truecolorcli 

5296 dictremove 

7018 entupd 

7706 getfiled 

8187\ 12253 initget 

9160 textbox 

9210 setenv\getenv 
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9280\12365\13293 entget 

9699 vl-catch-all-apply 

11118 tblsearch 

11141\11157 slide_image 

11142 eq\equal 

11412\12223 read 

11532\12116 vl-registry-read 

11620 vlr-objectmodified 

11636 vlr-editor-reactor 

11657 done_dialog 

11669 action_tile 

12079\12177 ssget 

12125 dos_copy 

12205 dictrename 

12238 grread 

12343 dos_serialno 

12446 getdist 

12732 vl-string-position 

12760 set_tile 

13068 type 

13107 getpoint 

12952\12953 entmod 
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New Commands 

The following section describes the new commands in this release. 

- Create and Modify Dynamic Block Definition 

Name Description 

BACTION Add actions to dynamic block definition. 

BACTIONSET 

Create new selection set for the action object, or 

modify the selection set associated with the action 

object in the dynamic block definition. 

BACTIONTOOL Add an action to a dynamic block definition. 

BASSOCIATE 
Associate an action with a parameter in the dynamic 

block definition. 

BAUTHORPALETTE 

Display Block Authoring Palettes window, including 

the Parameters tab, Actions tab and Parameter Sets 

tab. 

BAUTHORPALETTECLOSE Close Block Authoring Palettes window. 

BCYCLEORDER 
Set the cycling order for the grips in a dynamic block 

definition. 

BESETTINGS 
Set the display settings for the Block Editor, to 

change the display color, object, grip, text, etc. 

BGRIPSET 

Create, delete or modify the number of grips 

associated with the specified parameter, or restore 

the grips to its default position. 

BLOOKUPTABLE 
Define, modify or display the lookup table for the 

block definition. 

BPARAMETER 

Add the parameter with grips to dynamic block 

definition in block editor, to define the custom 

properties for dynamic block reference. 

BTESTBLOCK 
Open the current block definition in "Test Block 

Window" to test dynamic blocks. 

BVHIDE 

Hide the selected objects in the current visibility 

state or in all visibility states in the dynamic block 

definition. 

BVSHOW Show the selected objects in the current visibility 

about:blank#Parameter
about:blank#Action
about:blank#Parameterset
about:blank#Parameterset
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state or in all visibility states in the dynamic block 

definition. 

BVSTATE Set the visibility state for a dynamic block. 

- PDF Underlay 

Name Description 

PDFADJUST 
Adjust the settings for the PDF underlay, such as 

Fade, Contrast and Monochrome. 

PDFATTACH Insert a PDF file into a drawing as an underlay. 

PDFCLIP 
Modify the display of the PDF underlay with the 

specified clipping boundary. 

PDFLAYERS 
View and set the display of the layers in PDF 

underlay. 

- Annotative Object 

Name Description 

ANNOUPDATE 

Update selected annotative objects, to make the 

annotation property of the objects matches the 

current properties of their styles. 

OBJECTSCALE 
Add or delete supported scales for specified 

annotative text objects. 

- Layer Properties Manager Palette 

Name Description 

CLASSICLAYER 
Display the classic Layer Manager as modal dialog 

box 

LAYERCLOSE 
Close the Layer Manger as palette or modeless 

dialog box. 

LAYERPALETTE 
Display the Layer Manger as palette or modeless 

dialog box. 

- Sub Commands 

Commands Sub Commands Description 
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OFFSET 

Erase(E) 
Control whether to delete the original 

object after offset. 

Layers(L) 

Control whether to place the offset 

object in the current layer, or the layer 

on which the original object lies. 

MULTIPLE 
Repeat the offset operation using the 

current offset distance. 

QDIM 

Edit(E) 

Edit a series of dimensions and 

specify whether to remove or add a 

dimension point. 

Setting(S) 

Set the default object snap mode for 

specifying the origin of extension 

lines. 

OFFSET under 

XLINE\RAY 

Through(T) 

Draw an xline passing through a 

specified point after selecting the 

offset line. 

Erase(E) 
Control whether to delete the origin 

object after offset. 

Layers(L) 

Control whether to place the offset 

object in the current layer, or the layer 

on which the original object lies. 

HATCH GRATE A new hatch pattern GRATE is added. 

Windows under 

ZOOM 
Snap 

Objects in a specified rectangular 

window after zooming can be 

snapped. 

LAYDEL Name 

Through entering “N” or “Name”, a list 

containing the names of all layers 

(except for the selected one) will be 

shown and you can choose one or 

more layers to delete. 
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New System Variables 

The following section describes the new system variables in this release. 

- Create and Modify Dynamic Block Definition 

Name Description 

BACTIONCOLOR 

Set the display color for the action object in Block 

Editor. BYLAYER, BYBLOCK, index color and true 

color are all available for the color of action 

object. 

BDEPENDENCYHIGHLIGHT 
Control whether to highlight the object which is 

dependent on the selected object. 

BGRIPOBJCOLOR 

Set the display color for the grip object in Block 

Editor. BYLAYER, BYBLOCK, index color and true 

color are all available for the color of grip object. 

BPARAMETERCOLOR 

Set the display color for the parameter in Block 

Editor. BYLAYER, BYBLOCK, index color and true 

color are all available for the color of parameter. 

BPARAMETERFONT 
Set the font for the text of parameters and 

actions in Block Editor. 

BACTIONBARMODE 
Set whether to display the action bar or the 

separate action symbols. 

BPTEXTHORIZONTAL 

Set the align orientation for the parameter text in 

the Block Editor, to decide whether to always 

display the text horizontally or align the text 

with the dimension text of the parameter.  

BVMODE 
Control how to display the invisible objects 

under the current visibility state in Block Editor. 

- PDF Underlay 

Name Description 

PDFOSNAP 
Control whether to enable the object snapping 

for the geometry in PDF underlay. 

PDFFRAME 
Control whether to display and plot the frame in 

PDF underlay. 
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- Annotative Object 

Name Description 

MSOLESCALE 
Control the initial size of an OLE object with text 

which is pasted on the Model space. 

ANNOALLVISIBLE 

Control the display of the annotative objects 

which do not support the current annotation 

scale. 

ANNOAUTOSCALE 

Control whether annotative objects are updated 

to support the annotation scale when you change 

it. 

ANNOTATIVEDWG 
Control whether the drawing is inserted into 

another drawing as an annotative block. 

CANNOSCALEVALUE Display the value of the current annotation scale. 

CANNOSCALE 
Set the name of the annotation scale for the 

current space. 

DIMANNO 
Indicate whether the current dimension style is 

an annotative style. 

HPANNOTATIVE 
Control whether a newly created hatch pattern is 

annotative. 

- Layer Properties Manager Palette 

Name Description 

LAYERDLGMODE 

Control whether to display the modal dialog box 

or modeless dialog box (palette) of the Layer 

Manager. 

LAYERMANAGERSTATE 
Control whether to display or close the 

Layer Manager. 

- Others 

Name Description 

WORKSPACELABEL 
Controls whether the name of the current 

workspace is displayed in the status bar. 

GRIPADSORB Control the display range that grips can adsorb. 
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DWFDELMODE 
Control whether a block reference that 

generated from a DWF/DWFx file can be deleted. 

LENSLENGTH 
Store the length of the lens used in the active 

viewport, and the unit is millimeter. 
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Bug Fixes 

There are 563 bug fixes in ZWCAD 2019 Official from overseas customers. The 

following list contains parts of them in this release. 

Bug ID Description 

Open and Save 

12377 
Open: The prompt that fonts are lacked should not occur 

when the fonts are already under the search path. 

11675 
Open\Menu: When opening drawing in server, if the 

storage path is long, the menu will drop down slowly. 

User Interface 

17135 
CUI\WIN32: Icons of commands cannot be dragged to 

specific locations in the toolbar on WIN32. 

10771 
CUI\XP: Icons of commands cannot be moved to specific 

locations in the toolbar on XP. 

9749 
Skin: The toolbars is displayed incorrectly in Windows 

Classic theme. 

Design 

12161 
xref\ucs: xrefs are always attached in WCS instead of 

UCS. 

8354 
Osnap\Parallel: It is impossible to draw lines or polylines 

parallel to another polyline. 

11858 
Explode\Hatch: The result is incorrect after exploding 

hatched patterns. 

API 

12105 Fail to Redo after executing Undo in lisp program. 

8729 
Display is not updated after modifying entities in the call

back function of zcedRegisterFilterWinMsg. 

13789 

There is performance problem when creating selection se

t with zcedSSGet by specifying multiple values on DXF gr

oup code. 

For the complete list of Bug Fixes, you can visit: 

https://zwcad.freshdesk.com/support/solutions/articles/24000028976--what-s-

fixed-in-zwcad-2019-official 

https://zwcad.freshdesk.com/support/solutions/articles/24000028976--what-s-fixed-in-zwcad-2019-official
https://zwcad.freshdesk.com/support/solutions/articles/24000028976--what-s-fixed-in-zwcad-2019-official
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Limitation and Notes 

The following section describes some details of limitation and notes in this release. 

Bug ID Description 

13611 The preview of Annotative Objects fail to be displayed. 

13550 
When dragging annotative blocks to the current drawing, the 

annotative properties will lose. 

13472 

13473 

13475 

When the annotative objects of different scales are added to 

an entity, their positions will be displayed incorrectly. 

13618 
When changing the scale of the annotative rotated dimension, 

the rotated effect will lose. 

13580 The Super Hatch for annotative blocks is displayed incorrectly. 

13576 Annotative marks cannot be displayed in the annotative styles. 

12911 
Dynamic Blocks containing parameterized objects cannot be 

edited in Block Editor. 

13055 
BCYCLEORDER/insert: When inserting Dynamic Blocks, the 

inserting point cannot be changed by pressing Ctrl. 

13972 

bedit/blookuptable: Only single value can be entered into the 

lookup table, while multiple values or range values are not 

supported. 

13043 
pdfosnap: Some objects in the PDF Underlay cannot be 

snapped correctly. 

12908 
NewUI\toolbar: Toolbar input box shows extra lines after 

turning the icons into big ones. 

11803 
copyclip/pasteclip: If specific drawings are copied incorrectly, 

there is hang-up and no response when being pasted. 

13401 
Xref/efficiency: It is slow when binding a specific xref in some 

drawings. 

13375 layout: It is slow to switch the layouts of specific drawings. 

14036 

block/zwcad.dwt/units: In the new drawings created in 

zwcad.dwt mode, the coordinates in the Block dialog is 

incorrect. 

 


